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Scorecards are, as you would expect, the places where players’ scores are kept.  
They can contain scores for one or more competitors and team scores that 
represent combinations of individual scores (like four-ball scores) or scores 
for balls played by more than one player (like foursome or scramble scores).

Mulligan’s Eagle uses the symbol at the left to represent information on a 
scorecard.
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Creating New Scorecards
Except when creating scorecards automatically by adding competitors to an 
event, you will create a new scorecard any time you need to enter scores for a 
player.  There are several ways to start:

From Eagle’s Main Window
With Eagle’s main window front-most, show the list of scorecards, then click 
the Add button at the lower left corner to continue opening a dialog where 
you can select the players to appear on the scorecard.

Note: If the Add button is not available (the button is dim), the scorecard list has 
been locked to prevent the addition or removal of scorecards (see “Authorization” on 
page 10).

Or, from the main window, show the list of players, hold the ⌥ (option) key 
down and double-click the name of a player.  Eagle will open a new score-
card for that player.  If the player has a “preferred” course, the scorecard will 
be configured for that course and the player’s preferred tees.

Or, from the main window, show the list of players and select all the players 
to appear on one or separate scorecards.  To make a single scorecard contain-
ing all the selected players, choose Scorecard for Selected Players from 
the Players section of the Golf menu or type ⌘S (command-S).  To open 
a separate scorecard for each of the selected players, choose Scorecards for 
Selected Players from the Players section of the Golf menu or type ⇧⌘S 
(shift-command-S).

Note: If the menu option is not available (the item is dim and inactive), there are 
no players selected in the list or the scorecards list has been locked to prevent the 
addition and removal of scorecards (see “Authorization” on page 10).

Or, from the main window, show the list of players and select all the players 
to appear on one or separate scorecards.  To make a single scorecard contain-
ing all the selected players, click the Make Scorecard button at the bottom 
right of the main window.  To open a separate scorecard for each of the 
selected players, hold down the ⌥ (option) key and click the Make 
Scorecard button.

Note:  If the Make Scorecard button is not available (the button is dim), there are 
no players selected in the list or the scorecards list has been locked to prevent the 
addition or removal of scorecards (see “Authorization” on page 10).
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From the New Menu
Or, choose New… in the File menu or type ⌘N (command-N) to see a dia-
log allowing you to make a new item:

New Dialog

Select the option to make a new scorecard, then click the New button.  You 
will continue by selecting the players to appear on that new scorecard.

Note: If the new scorecard option is not available (the button is dim), the score-
card list has been locked to prevent the addition or removal of scorecards (see 
“Authorization” on page 10).

From the New… Submenu

New Submenu

Or, choose Scorecard in the New… submenu in the File menu, or type ⌥⌘S 
(option-command-S) to create a new scorecard and continue by selecting 
the players to appear on it.

Note: If the menu option is not available (the Scorecard item is dim and disabled), 
the scorecard list has been locked to prevent the addition or removal of scorecards 
(see “Authorization” on page 10).



78 Creating New Scorecards

From a Player Window
Or, with an editing window for a player front-most, show the Scores panel, 
then click the Add button at the lower left corner.  Eagle will open a new 
scorecard for the player.

Note: If the Add button is not available (the button is dim), the scorecard list has 
been locked to prevent the addition or removal of scorecards.

Or, with an editing window for a player front-most, show the Scores panel, 
then choose Scorecard for Selected Players from the Players section of 
the Golf menu or type ⌘S (command-S).

Note: If the menu option is not available (the item is dim and inactive), the score-
card list has been locked to prevent the addition and removal of scorecards (see 
“Authorization” on page 10).

If the player has a “preferred” course, the new scorecard will be configured for 
that course and the player’s preferred tees.

Selecting Players for a Scorecard

Player Selection

In the New Scorecard dialog, select the player or players to appear on that 
scorecard, then click New Scorecard.  A new scorecard window will open 
with all of the selected players assigned to the scorecard.  Continue setting 
up the scorecard like you would when editing an existing scorecard.

If you decide not to make a new scorecard, just click Cancel to proceed.

Note:  There are no “empty” scorecards in Mulligan’s Eagle.  At least one round 
must appear on a scorecard and if that round is removed, the scorecard itself is 
automatically deleted.
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Editing Scorecards
Opening an Existing Scorecard
Show the list of scorecards in Eagle’s main window and select the scorecards 
for which you need to change information.  Click the Edit button at the 
lower left corner and each of the selected scorecards will be opened for you 
to review information and make changes.

Or, open the scorecards by selecting them in the list and choosing Open 
from the File menu or typing ⌘O (command-O).

Or, just double-click the name of a scorecard in the scorecard list.

Note: If the Edit button is not available (the button is dim), there are no scorecards 
selected in the list.  Scorecards can be edited even when the scorecard list is locked.

Or, with an editing window for a player front-most, show the Scores panel.  
To open a scorecard for a round in the list, select the rounds of interest and 
click the Edit button at the lower left corner.  The scorecards containing the 
selected rounds will be opened for your review.  You may also open scorecards 
for the selected rounds by choosing Open from the File menu, typing ⌘O 
(command-O), or simply double-clicking a round in the list.

Configuring a Scorecard
A scorecard window contains all the information about a round of golf 
for one or more players.  When opening a new scorecard, considering the 
player’s preferred course and tees, Eagle makes a “best guess” about how the 
scorecard should be set up.

Configuring a Scorecard

Club – Start typing the name of the golf club or choose the club at which the 
rounds on this scorecard were played.  This field is not editable on scorecards 
associated with an event.
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Course – Choose the course at this club on which the rounds were played.  
This field is not editable on scorecards associated with an event.

Date – A date for the rounds on this scorecard is required.  The date, by 
default, is set to the current date, but a date in the past or a date in the future 
is valid.  This date cannot be changed on scorecards associated with an event.

Tee – It is assumed that the rounds begin on the tee of the 1st hole.  If the 
round begins on another tee, enter that number.  You may also use modify-
ing alphabetic characters (ie: “1A,” “6B,” etc.) to indicate the first or second 
group  from the specified tee.

Time – The tee time is usually only needed for events in which the com-
petitors start at different times from the same tees.  Enter or increment or 
decrement the time to set a tee time.

Sides – Make sure the popup menus for the front and back side reflect 
the nines that were played in this round.  For courses with more than two 
nines, select the nines played as the front and back side.  The sides cannot be 
changed on a scorecard associated with an event.

Note:  If you are recording rounds on a scorecard for players who played the course 
in an unusual manner (Back Nine first, same nine twice, etc.), there are no restric-
tions on how you configure the scorecard or record the scores.  If the rounds will 
be compared to those of other players on other scorecards - matching rounds in 
some fashion, it is easier to do so by configuring all the scorecards using the same 
sides.  Scorecards for a “shotgun” start, where players start at the same time from 
different tees, should be configured normally (Front Nine, Back Nine) though dif-
ferent players may not play the holes in precisely that order.  Scorecards for events 
are automatically configured identically, and the club, course and sides cannot be 
altered on those individual scorecards.

If the rounds recorded on this scorecard are 9-hole rounds, make sure the 
front side popup menu indicates the nine played and the back side popup 
menu is set to none:

9-Hole Rounds

When only 9 holes are selected on a scorecard, total yardage, par, and the 
playing handicaps of the players will be adjusted accordingly.

Options – Click the button to show a menu to choose scorecard-specific 
actions or settings.  See “Scorecard Options” on page 82 for details.
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Hole numbers, Lengths, Par and Handicaps – When you have indicated 
the club, course and sides for this scorecard, the scorecard window will dis-
play the hole numbers, yardages, par and hole handicaps for the tees chosen 
for the players on the card:

Tees, Par & Handicaps

If there are gender differences in par or the hole handicaps (as illustrated 
above), they are shown separately.  The Course Rating and Slope Rating for 
rounds played from each tee are shown to the right.  As players are added or 
removed from the scorecard, or their chosen tee changes, there will be corre-
sponding changes to this displayed information on the scorecard.

Competition Scoring
In addition to the player’s gross scores, handicap and net result, scorecards 
include another layer of information – competition scoring.  If the player’s 
score needs to be calculated as Stableford points, determined from a special 
handicap allowance, or compared to teammates on the same scorecard, those 
“extra” results are competition scoring.  In an event, competition scoring 
is frequently the result that appears on the scoreboard.  Without an event, 
Eagle provides features to let you review and configure competition scores 
for each player’s round or for the whole scorecard.  By default, the competi-
tion scores for a player’s round are their hole-by-hole net scores using their 
playing handicap - or medal play with a full handicap allowance.  Both the 
style of play and the allowance can be changed to produce different results.

Mulligan’s Eagle uses a trophy symbol to represent those features of the 
software related to competition scoring.

Some competition scoring features apply to all the rounds on the score-
card.  Those features are configurable by setting scorecard options, which are 
described in the next section.  Other competition scoring capabilities are spe-
cific to an individual player’s round and those features are controlled by the 
Competition Scores item discussed with “Player Round Options” on page 
86.  Generally, if a scorecard and its rounds are associated with an event, 
the settings for competition scoring are dictated by that event and are not 
modifiable on the scorecard.
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Scorecard Options
The scorecard Options menu allows you to choose certain scorecard-specific 
actions and settings.  Click the Options button to show a drop-down menu:

Scorecard Options

Add a Player to this Scorecard – Choose this menu item or type ⇧⌘A 
(shift-command-A) to open a sheet on this scorecard window to add a 
round for another player to the scorecard.  See “Adding a Player” on page 
87 for details.

Show (Hide) Notes – Choose this menu item or type ⇧⌘N (shift-com-
mand-N) to show or hide a drawer to enter notes about the scorecard:

Notes

You can type whatever you like in the window.  Clear the notes by clicking 
the Clear button on the drawer.  Close the drawer by clicking the Close but-
ton on the drawer or typing ⇧⌘N again.  A little blue indicator adjacent to 
the Options button reminds you that there are notes on file.
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Tournament Scorecard – When checked (✓), indicates that this is a “tour-
nament” scorecard, a status that might effect handicapping calculations for 
the player’s rounds.  When unmarked, indicates that this is not a tourna-
ment scorecard.  Choose this menu item or type ⇧⌘T (shift-command-T) 
to identify the rounds on this scorecard as tournament or “organized com-
petition” scores.  Scorecards for these rounds are also indicated by a little  
symbol adjacent to the scorecard Options button:

Note:  The “tournament scorecard” status describes the scorecard, not the rounds.  If 
you have rounds on a tournament scorecard that aren’t tournament rounds, you 
should create another scorecard for them.

Note:  If the Tournament Scorecard menu option is dim and unavailable 
(checked or unchecked), the scorecard’s “tournament scorecard” status is controlled by 
an associated event (see “Record as Tournament scores” page 111).

Adjust for Tee Ratings – When checked (✓), indicates that handicap allow-
ances on this scorecard are being adjusted for differences in Course Ratings 
for play from different tees (or different genders from the same tee).  If 
unchecked, no ratings adjustment has been calculated.  Choose this menu 
item or type ⇧⌘R (shift-command-R) to make or clear the allowance 
adjustment.

Show (Hide) Skins – Choose this menu item or type ⇧⌘K (shift-
command-K) to show or hide holes that are computed as “skins” on this 
scorecard or in the event associated with this scorecard.  Holes scored as 
“skins” are displayed with a special colored background.

Competition Summary – Choose this item or type ⌘D (command-D) to 
display a sheet showing the competition scoring summary for this scorecard, 
described at “Competition Scoring – Scorecard” on page 95.

Competition – Select the type of individual competition scoring to be used 
on this scorecard.  The default setting is Medal Play (stroke play).  See 
discussion of “Competition Scoring” on page 81.  For descriptions of 
competitions that may be unfamiliar, see the “Glossary” on page 199.

Competition Allowances – Select the type of handicap allowance for 
computing competition scores on this scorecard.  The default setting is Full 
Handicap.  See discussion of “Competition Scoring” on page 81.

Add a Team Score – Select a style of team score to be added to the score-
card.  A team score might be calculated from individual player scores on this 
scorecard (like four-ball) or represent a score made by the teammates playing 
one ball (like foursomes).  For descriptions of team competitions that may be 
unfamiliar, see the “Glossary” on page 199.
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The preceding 3 options - Competition, Competition Allowances, and 
Add a Team Score - allow you to set up inter-player competition, use spe-
cial allowances or add a team round score to this scorecard only.  For example, 
you can set up a 9-Point Game competition for 3 players, with the A-player 
playing scratch.  Or, you can add a team score of 2 Best-Balls that will be 
computed automatically and might be used for scoring a match against a 
team on another scorecard.  Adding these competitions or rounds to the 
scorecard have no effect on the scoring history of the player.  These compe-
tition features are not configurable on a scorecard associated with an event.  
The event dictates what kinds of competition, allowances and team scoring 
appear on its scorecards.

Match… – If the scorecard includes rounds for just one or two players, 
choose this menu item, or type ⌥⌘M (option-command-M), to open a 
Match window for a match between the players.

Print this Scorecard… – Open the printing dialog to print this scorecard.

Event… – If this scorecard is associated with an event, open the window for 
that event and bring it to the front.

Players’ Rounds
Each player’s round on the scorecard has an area for configuration and 
scoring:

Player’s Round

Player designator – on scorecards with more than one player, the players 
are designated by an alphabetic character (A, B, C, etc.) that indicates their 
relative position on the scorecard.  If you want a player to be the “A-Player,” 
move them to the top of the list of players.

Player’s Name – The player’s name is draggable and can be dragged wher-
ever a round can be used, like the scoring areas in a Match window.
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Tee – Use the tee popup menu to choose the tee played during this round:

Tee Selection

Handicap – The title to this field indicates the type of official handicap used 
to compute a playing handicap and allowances for this round.  The com-
puted (or looked-up) default value is shown in the text box in dim text.  This 
default value will be used unless it is overridden by typing another value in 
the text box.  A little blue indicator adjacent to the text box indicates it con-
tains an overridden value.  To remove an overridden value, select it and type 
⌫ (delete).

Putts – Click this button to open a sheet just below the scores for this player 
to enter putts and other information about the round.  (See “Entering Putts 
and Other Detail” on page 93 for details.)  When the option key is held 
down, this button becomes the Competition Scoring button.

Competition Scoring – With the option key held down, click this button 
(the same as the Putts button) to display a sheet showing competition 
scoring results for this round.  See “Competition Scoring – Player’s Rounds” 
on page 95 for details.  See “Competition Scoring” on page 81 for a 
discussion of competition scoring.

Move up – Click to move this round up - ahead of the player just above.  The 
button is dim and not available when the player’s round is already the first on 
the scorecard.

Move down – Click to move this round down - after the player just below.  
The button is dim and not available when the player’s round is already the 
last on the scorecard.

Moving players rounds up or down changes their “A,” “B,” “C” player desig-
nation, and may (if the application settings specify) change the name of the 
scorecard or any team on the scorecard of which they’re a member.

Options – Click this button to perform actions or adjust settings about this 
round.  See “Player Round Options” on page 86 for details about round 
options.
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Player Round Options
The round Options menu allows you to choose certain actions and settings 
for this player’s round:

Round Options

Edit information about Player – Open a player editing window for this 
round’s competitor and bring it to the front.

Make Tees on this Golf Course the Player’s Preferred Course – Choose 
this menu item to make the settings of this scorecard (club, course, front and 
back side, tee) the preferred settings of the player.

Event… – If the round is associated with an event, open a window for that 
event and bring it to the front.

Putts… – Open a sheet to enter putts and other information for this round.  
This is the same action as clicking the Putts button.  See “Entering Putts and 
Other Detail” on page 93 for details.

Competition Scores… – Open a sheet to review or configure competition 
scoring for this round.  This is the same action as clicking the Competition 
Scoring button (the Putts button with the option key down).  See 
“Competition Scoring – Player’s Rounds” on page 95 for details.

Match for Player… – Open a match window with this player’s round 
installed as the “A” competitor.

Show Handicap Dots – Show dots on the scorecard representing the handi-
cap strokes allowed this player at each hole.

Move Round Up – Move this round up on the scorecard ahead of the round 
above it.  This is the same action as clicking the Move Up button.
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Move Round Down – Move this round down on the scorecard after the 
round below it.  This is the same action as clicking the Move Down button.

Delete Round… – Delete this round from the scorecard.  You will be asked 
to confirm that you want to delete the round from the scorecard and from 
the player’s scoring record.  You can’t delete the last round on a scorecard - 
you’ll have to delete the scorecard instead.

Split Scorecard – Move this round to a separate new scorecard.  You may 
only move the round if it is not the last round on the scorecard and the 
round is not required to calculate a team round also on the scorecard.

Ignore for Handicapping – When checked (✓), indicates that this round 
will be ignored in the computation of the player’s handicap (perhaps 
because it is not played under the Rules, or some other reason for exclusion).  
Otherwise, the round will be included in the player’s scoring record and con-
sidered in handicapping calculations.  Choose this menu item to ignore or 
include the round.  When ignored, a little  symbol is shown adjacent to the 
handicap text field on the scorecard.

Note:  If the player’s round is marked as ignored for handicapping (the Ignore for 
Handicapping option is checked and the round is marked with the   symbol) but 
the rounds status cannot be changed, the round is associated with an event which 
specifies that the round should be ignored for both accumulation of statistics and 
handicapping (see page 111).

Penalty Round – Make this a penalty round.  A little red indicator to the 
right of the Options button is used to indicate a penalty round.  Penalty 
rounds are typically posted as a substitute for an unreturned scorecard (see 
the Glossary).

Disqualified – When checked (✓), indicates that this round has been dis-
qualified from competition in the associated event.  The menu item is only 
enabled when this round represents the competitive score in an event or is 
one of the rounds used to calculate a team’s competitive score in an event.  A 
round may be disqualified from, or restored to, competition by choosing this 
menu item.

Clear Scores – Choose this menu item to clear all of the scoring informa-
tion entered on this round, including the player’s scores, putts, any fairways 
or greenside bunkers hit, penalty strokes or other status indicators.

Adding Rounds to a Scorecard
Adding a Player
You can add a round for a player to an open scorecard by choosing Add a 
Player to this Scorecard from the scorecard Options menu (page 82) or 
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by typing ⇧⌘A (shift-command-A).  A sheet will be opened for you to 
select a player:

Adding Players

Select one or more players to appear on the scorecard and click the Add 
button.  Players who are shown with dim text are already on the scorecard 
(or in an event, on another scorecard associated with the event) and can’t 
be selected.  The rounds of players newly added appear at the bottom of the 
scorecard.

Added Player

You can also quickly add a single player to an open scorecard by dragging the 
player’s name from the Players panel of Eagle’s main window onto the score-
card window.  In this case, players are added at the bottom of the scorecard 
or at the highlighted point between other rounds on the scorecard.
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Adding a Team Round
If you want to add a team score, to calculate a best-ball or add a round for a 
ball played by the players on the scorecard, choose one of the submenu 
options from the Add a Team Score item in the scorecard Options menu 
(page 83).  Eagle will add the selected type of team round to the scorecard, 
and it will assume that all of the individual players on the scorecard are 
teammates for this added round.

Team Round

The team round scoring fields are near the bottom of the scorecard.  Some 
types of team rounds are calculated from the scores of the individual players, 
like the four-ball score in the illustration above.  Others, like Greensomes or 
a Scramble, require that you enter a score for the team ball at each hole.

You can indicate how the teammates’ handicap allowances should be cal-
culated by choosing an appropriate allowance from the Competition 
Allowances submenu in the scorecard Options menu.  The default is Full 
Handicap.  If the team score is to be calculated from Stableford points or 
by some other method, choose the method of competition scoring from the 
Competition submenu in the scorecard Options menu.  The default is Medal 
Play.

For team rounds not associated with an event, you may modify the type of 
team play using the popup menu at the bottom of the team scoring area, as 
shown in the preceding illustration.  For team rounds that use team allow-
ances (like a Scramble), you may also modify the team’s handicap allowance 
with a popup menu that will be available for that purpose.  Because team 
rounds associated with an event are controlled by the setup of that event, 
these popup menus are not available.
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Team Name – The name shown for the team is draggable, and can be 
dragged to any location expecting a round, like the competitors in a match 
window.

Move Up – Click this button to move the team round upward relative to 
other team rounds on the scorecard.  Team rounds will always remain below 
individual player’s rounds on the scorecard.

Move Down – Click this button to move the team round downward relative 
to the other team rounds on the scorecard.  Team rounds are always at the 
bottom of the scorecard.

Options – Click this button to display a menu for you to choose activities or 
settings associated with this round.  See the next section for details about 
these options.

Team Round Options
Like individual player rounds, you can configure team rounds from the 
Options menu:

Team Round Options

Edit Teammates… – Display a sheet allowing you to add, remove or change 
teammates for this team round (see “Adding and Removing Teammates” on 
page 91).

Event – If this team round is associated with an event, choose this item to 
open a window for the event and bring it to the front.

Competition Summary – Choose this menu item or type ⌘D (command-
D) to see the details of the individual scores that comprise the net team score.  
See “Competition Scoring – Scorecard” on page 95 for details.

Move Round Up – Move this team round upward relative to the other team 
rounds on the scorecard.  This is the same action as clicking the Move Up 
button.
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Move Round Down – Move this team round downward relative to the other 
team rounds on the scorecard.  This is the same action as clicking the Move 
Down button.

Delete Round… – Delete this team round from the scorecard.  You will be 
asked to verify that you want to delete the round permanently.  Rounds that 
represent competitive scores for an event should be removed from the event.  
To do so, choose Event… in this menu to open an event window, then use the 
Options menu there of the associated contestant to delete the round.  You 
cannot delete the last round on a scorecard directly - you must delete the 
scorecard.

Net Score in Tenths – When checked (✓), indicates that the handicap 
allowance and the net score determined from that allowance are both cal-
culated to a tenth of a stroke (0.1 strokes).  When unchecked, net scores are 
reported to the nearest stroke.  The ability to calculate fractional net scores 
helps avoid ties in some types of competition.  This menu item is not avail-
able for rounds associated with an event - the event setup dictates whether 
net scores are calculated in tenths.

Disqualified – When checked (✓), indicates that this round has been dis-
qualified from competition in the associated event.  The menu item is only 
enabled when this round represents a team’s competitive score in an event.  A 
round may be disqualified from, or restored to, competition by choosing this 
menu item.

Adding and Removing Teammates
Even after a team round has been added to a scorecard, you can change the 
teammates whose play contributes to that round.  You begin changing team-
mates by choosing Edit Teammates… from the team round Options menu 
(page 90).  A sheet is displayed below the team round scoring area:

Adding or Removing Teammates
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The team members are shown at the left, with their chosen tee, handicap and 
playing handicap.  To add one or more teammates, select them from the list 
of players on the right, then click the Add button.

To remove players from the team, select them in the list on the left, then 
click the Remove button.  If necessary, Eagle will add or remove individual 
rounds on the scorecard to accommodate the style of team play indicated. 

Players in the list on the right whose names are shown in dim text are 
unavailable to add to this team because they’re already members of the team 
or members of another team in any associated event.

Team Name – You may provide an alternative name for the team by typing 
it into the text field at the left.  The dim text shown represents the way the 
team will be described without an alternative name.

Tee – Choose a tee from which a teammate will play the round.

Index – This column indicates the official, calculated or looked-up handicap 
for a teammate.  If there is no individual round on the scorecard associated 
with the teammate (as in a Scramble or Foursomes), you may override this 
value by double-clicking it and typing an override value.

Hdcp – This column indicates the playing handicap for a teammate.  If there 
is no individual round on the scorecard for the teammate, you may override 
this value by double-clicking it and typing an override value.

Note: Different types of team play require a specific number, or minimum number, 
of players.  You should avoid reducing the number of players on the team below the 
minimum number (shown below the list of teammates) to make sure team scores 
can be computed.

Click Done when you’re done reviewing or editing teammates.

Scoring
Entering Scores
You may enter scores on a scorecard in as much detail as you want.  You may 
enter a round simply by entering the gross total for that round.  Or, you can 
enter scores for each side, and Eagle will compute the total.  Most likely, 
however, you will enter players’ scores hole-by-hole.
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When you open a new scorecard for a player, it opens ready to enter scores, 
with the flashing cursor at the first hole:

Ready for Entering Scores

To enter scores, simply type the player’s hole-by-holes gross scores.  You don’t 
need to type tab, enter or return keys after each hole.  Eagle will automat-
ically tab to the next hole when you’ve entered a valid score.  On a good day, 
that means you can enter the hole-by-hole scores for an 18-hole round with 
18 keystrokes.  On a really good day, when you need to record a 1, type “1” 
followed by the tab key.  The result looks something like:

Score Entry Complete

Sub-par, par and over-par scores are readily identified by their color.  If a 
playing handicap is available, the net score for the round is shown.  The little 
green indicator ( ) to the right means “scoring complete” - you’ve entered 
enough information to use this round for analysis or handicapping.  Rounds 
for which scoring is not complete can also be identified in a player’s list of 
rounds by their “dim” appearance in the list.

Entering Putts and Other Detail
If you want Mulligan’s Eagle to perform analysis on other parts of your (or 
any player’s) game, you can provide the additional information about the 
round by clicking the Putts button which displays a sheet immediately below 
the scores just entered:

Putting and Scoring Details

Putts – Just like entering scores, you can enter your hole-by-hole putts by 
typing numbers like 0, 1, 2, 3, etc. and Eagle will automatically tab to the 
next hole when you’ve entered a valid number.  Note as you proceed entering 
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putts that the big Hole number indicates the hole in which the insertion 
point is located, and the editable data immediately to the right of that num-
ber is associated with that hole.  To set the big Hole number, click to put the 
insertion point in the putting entry field for a hole.

Fairway – Click the Fairway ( ) button at the holes on which you hit the 
fairway with your first shot from the tee.  If you are recording fairways hit 
but hit no fairways in this round, click the No Fairways ( ) button to 
the right.  You may also “set” the Fairway button for the hole indicated by 
the big Hole number by typing the shorthand key for a fairway hit - an 
“F” by default.  To “unset” the Fairway button, type ⇧F (shift-F) or ⌥F 
(option-F). 

Sand – Click the Sand ( ) button at the holes on which you were in a 
greenside bunker with the opportunity to make par (a “sand try”).  You may 
also “set” the Sand button for the hole indicated by the big Hole number by 
typing the shorthand key for a greenside bunker hit - an “S” by default.  To 
“unset” the Sand button, type ⇧S (shift-S) or ⌥S (option-S).

CCR – If the handicapping method in use for this player requires it, a text 
field is shown for you to provide the Calculated Course Rating (CCR) or 
Calculated Scratch Score (CSS) for this round.  This number is a value that 
represents the course rating adjusted for weather and other conditions on the 
day of play.

Up & Down – Check this box if you want to record an “up & down” at the 
hole indicated by the big Hole number.  You may also record an up & down 
for the hole indicated by the big Hole number by typing the shorthand key 
for an up & down - a “U” by default.  To reset the up & down setting, type 
⇧U (shift-U) or ⌥U (option-U).

Green in Regulation – Check this box if you want to record a “green in regu-
lation” at the hole indicated by the big Hole number.  If you provide a score 
and putts, Eagle will check this box for you.  You may also record a green 
in regulation for the hole indicated by the big Hole number by typing the 
shorthand key for a green in regulation - a “G” by default.  To reset the green 
in regulation setting, type ⇧G (shift-G) or ⌥G (option-G).

Penalty Strokes – Increment (or decrement) the number of penalty strokes 
you want to record at the hole indicated by the big Hole number.  You can 
reset the number of penalty strokes to zero by clicking the zero button.  You 
may also add a penalty stroke for the hole indicated by the big Hole num-
ber by typing the shorthand key for a penalty stroke - a “P” by default.  To 
subtract a penalty stroke, type ⇧P (shift-P).  To reset the number of penalty 
strokes to zero, type ⌥P (option-P).

The use of the “F”, “S”, “U”, “G” and “P” keys described above and others used 
for scoring is further described in “Scoring Shorthand” on page 180.
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Adjusted Gross Score – Eagle computes an adjusted gross score after 
applying limits to individual hole scores based on the requirements of the 
handicapping system in use for the player.  This value is displayed for review.

Greens in Regulation – The total number of greens in regulation calculated 
or entered for this round is displayed for review.

Sand Saves / Tries – The number of sand saves and the number of sand tries 
for the round are displayed.

Competition Scoring – Player’s Rounds
You can review the calculated net or competition scores for a player’s round 
by holding down the option key and clicking the Competition Scoring 
button, which is the same as the Putts button.  A sheet will be displayed 
immediately below the player’s scores that describes the net or competition 
scores for the round:

Competition Score Display

The competition scoring display includes the handicap allowance strokes and 
the net or competition score in the style specified for this round.  For rounds 
that are not associated with an event, the type of competition scoring can 
be set by the popup menu at the left.  The default for individual rounds is, as 
shown, Medal Play.  The allowance popup menu allows you to choose the 
calculation method for the handicap allowance for this round.  The compe-
tition results themselves are shown in the displayed Score.  Click Done to 
dismiss the sheet.

Competition Scoring – Scorecard
You can adjust the competition scoring and allowance settings for all of the 
individual rounds on a scorecard with the Competition and Competition 
Allowances scorecard options (see “Scorecard Options” on page 82).

From the scorecard, you cannot adjust competition scoring methods or 
allowances for rounds associated with an event.  Those settings are controlled 
by the configuration of the event.

To display a summary of the competition scores, including both indi-
vidual scores and team scores derived from the individual scores, choose 
Competition Summary… from the scorecard options (“Scorecard Options” 
on page 82) or from any team round options (“Team Round Options” on 
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page 90), or type ⌘D (command-D), or hold the shift and option keys 
down while you click the Competition Scoring (Putts) button.  A sheet will 
open displaying the data:

Competition Summary

The summary will display the competition scores of all the players on the 
scorecard, as well as team scores derived from the individual scores.  Click 
Done to dismiss the sheet.

Importing Scores
For large events or situations in which scores are recorded either by another 
copy of Mulligan’s Eagle or with a compatible iOS application, scoring and 
other information may be imported from data produced elsewhere.

Choose the one of the options in the File / Import menu available for 
importing scores:

Import Menu - Scores

From Mulligan Scoring Data Files
Scoring files are Mac documents that contain all the detailed information 
about one or more rounds of golf, demographic information about the golf 
course played and the competitors.  Scoring files may have been exported 
from Scorecards by Mulligan’s Eagle or from compatible applications on 
remote devices.
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Begin importing scoring data by choosing Scores from Mulligan Scoring 
Data Files… from the Import submenu in the File menu.

Note:  If the menu option is unavailable (the item is dim and inactive), the player 
or scorecard list has been locked to prevent the addition or removal of scores.

Use the displayed dialog to locate the scoring data files to be imported:

Choosing Scoring Data Documents to Import

Navigate until you have found the files, then select those you want to import.  
Click the Import button when you are ready to continue.

The application will display a dialog that will show your progress importing 
each of the selected scoring data files:

Scoring Data Import

Click the Import button to import the data.  The progress dialog will close 
automatically when the process is complete.  All the data will be imported.  If 
a scorecard of the proper date matching the round being imported is already 
on file, scores will be imported, replacing any existing data.  If an incoming 
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player or golf course can’t be found, they will be created.  If necessary, a score-
card will be created to accommodate incoming scores.

From Dropbox
If you have an active Dropbox account, scores entered and saved to your 
Dropbox on a remote device can be reviewed and imported to Mulligan’s 
Eagle..

Begin importing scoring data by choosing Scores from Dropbox… from the 
Import submenu in the File menu.  The displayed window will list the avail-
able compatible Mulligan Scoring data files found in your Dropbox.  

Importing Scoring Data from Dropbox

Link / Unlink – Click Link to activate your Dropbox account using a previ-
ously registered account and password.  If you don’t have a Dropbox account, 
visit https://www.dropbox.com to sign up.   Click Unlink if you want to dis-
continue (log off ) using Dropbox.

Check for scores at startup – Eagle can initiate an automatic review of 
incoming scoring data via Dropbox every time it starts up.  Incorrect, incom-
plete or ambiguous data will be left for later review.  Other data will be 
imported into Eagle’s database.  Check the box to enable review at startup.
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When an incoming scoring record is selected (clicked) in the list at the left, 
the competitors, the golf course and the incoming scores are evaluated to 
determine whether the scoring record (in its entirety) can be imported.  Valid 
and complete data is identified by green or gray indicators.  Missing data 
about the golf course or a competitor will be identified by a red indicator.  
You can delete an incoming scoring record by clicking the Delete “-” button 
or you may take other action to install a competitor or the golf course into 
Eagle’s database or skip the entry of scores for a particular player.

Once you have specified how the incoming data is to be resolved, clicking 
the Import button will install or merge the scoring data into Eagle’s database 
and the players’ scoring history and the scoring data file will be deleted from 
your Dropbox.

From iCloud
If you purchased Mulligan’s Eagle from the Mac App Store, and you have an 
active iCloud account, you may import scoring data files from a special 
reserved “Mulligan Scoring” folder synchronized through iCloud.

Begin importing scoring data by choosing Scores from iCloud… from the 
Import submenu in the File menu.  The displayed window will list the avail-
able compatible Mulligan Scoring data files found on iCloud.  

Importing Scoring Data from iCloud
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Check for scores at startup – Eagle can initiate an automatic review of 
incoming scoring data in iCloud every time it starts up.  Incorrect, incom-
plete or ambiguous data will be left for later review.  Other data will be 
imported into Eagle’s database.  Check the box to enable review at startup.

When an incoming scoring record is selected (clicked) in the list at the left, 
the competitors, the golf course and the incoming scores are evaluated to 
determine whether the scoring record (in its entirety) can be imported.  Valid 
and complete data is identified by green or gray indicators.  Missing data 
about the golf course or a competitor will be identified by a red indicator.  
You can delete an incoming scoring record by clicking the Delete “-” button 
or you may take other action to install a competitor or the golf course into 
Eagle’s database or skip the entry of scores for a particular player.

Once you have specified how the incoming data is to be resolved, clicking 
the Import button will install or merge the scoring data into Eagle’s database 
and the players’ scoring history and the scoring data file will be deleted from 
iCloud.

Exporting Scorecard Information
Printing Scorecards
There are many options for printing scorecards for use on the course.  With a 
scorecard window open, choose Print from the File menu or type ⌘P (com-
mand-P), or choose Print this Scorecard… from the Golf menu.

Printing a Scorecard
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With one or more scorecards selected in the Players panel of Eagle’s main window, choose Print from 
the File menu or type ⌘P (command-P), or choose Print Selected Scorecards… from the Golf menu.  
When an Event window is open and frontmost, you may choose Print All Scorecards… from the Golf 
menu to print all the scorecards associated with the event.

In all those situations, Eagle allows you to “configure” how you would like the scorecards printed:
•	 Whether to “dot” the scorecard with handicap strokes, and whether to use the player’s playing 

handicap or their handicap allowance for the competition.
•	 Whether to print a player’s scores (if scores are available) and whether to print them in color.
•	 Whether to print a player’s initials near the space reserved for their total score.
•	 Whether to print extra scorekeeping areas on the scorecard for players to record special data 

(putts, etc.) or to display individual and / or team net or competition scores.

Eagle always prints scorecards to fit standard paper or cardstock, printed in landscape oreientation.  It 
always attempts to print as many complete scorecards as possible per page, considering appropriate spac-
ing and separation to produce high-quality printed cards for the competitors.

Exporting to a Mulligan Scoring File
You can export, or “save,” information about a scorecard to a Mac file.  This file can then be imported by 
another Mulligan’s Eagle software user or transported via a data network, like Dropbox or iCloud, to be 
imported automatically to a central computer running Mulligan’s Eagle.  (Exported Mulligan Scoring 
files are essentially identical to scoring files produced by Mulligan Software’s iOS applications running 
on remote devices.)

To export the information about a scorecard, start by opening a window for the scorecard (see “Editing 
Scorecards” on page 79).  Choose Export from the File menu or type ⌘E (command-E) to open a 
standard macOS save sheet in the window:

Exporting Scoring Data



102 Exporting Scorecard Information

Navigate to the location where you’d like to save the file, then click Export.  
Eagle will assign an appropriate name to the file, identifying the date of 
play, the course and competitors contained in the file.  Unless you indicate 
otherwise, Eagle will save the file in the Eagle User Data folder inside the 
Documents folder inside your user directory.

Mulligan Scoring files are stored with, and identified by, a .EAGS extension.

Exporting a List of Scorecards to a Spreadsheet
From Eagle’s main window, you can export data for selected scorecards to an 
open spreadsheet application.  With Eagle frontmost, select the scorecards of 
interest and drag the selection to the spreadsheet:

Dragging a selected list of scorecards to a spreadsheet

A tab-delimited, textual array is exported to the spreadsheet, including for 
each selected scorecard:

•	 Club name
•	 Date
•	 Player(s)

The data is organized in a tabular array, one scorecard per row, when inserted 
into the spreadsheet:

Spreadsheet Scorecard List
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Exporting Scorecard Data to a Spreadsheet
You can also export detailed information about a single scorecard to an open 
spreadsheet application by opening the scorecard, then dragging the icon at 
the top left of the window onto the spreadsheet:

Dragging detailed scorecard information to a spreadsheet

A tab-delimited, textual array is exported to the spreadsheet, including for 
the scorecard:

•	 Date
•	 Name (competitors’ names)
•	 Club name
•	 Course name
•	 Front nine
•	 Back nine
•	 Starting tee
•	 Tee time
•	 Tournament scorecard (yes or no)

and for each round on the scorecard:
•	 Competitor’s name
•	 Tee
•	 Tee color
•	 Holes 1 - 9 gross score and total
•	 Holes 10 - 18 gross score and total
•	 Gross score
•	 Playing handicap (Course Handicap, etc.)
•	 Net score
•	 Scoring complete (yes or no)
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•	 Disqualified (yes or no)
•	 Ignore for handicapping (yes or no)
•	 Trend handicap

Spreadsheet Scorecard Information

If your spreadsheet application has difficulty importing data dragged from 
Eagle (no columnar results, improperly interpreted numbers or spacing, etc.), 
you may need to change the format of the dragged information.  See “Drag 
& Drop data delimiters” on page 17 for more information.

Deleting Scorecards
With Eagle’s main window front-most, show the list of scorecards, select 
(click, shift-click or command-click) the scorecards to be deleted, then 
click the Remove button at the lower left corner.  Or, choose Delete from 
the Edit menu, or type ⌫ (delete).  You will be asked to confirm that you 
really want to delete the scorecard(s).  Click OK to delete or Cancel to 
continue without deleting.

Deletion is permanent and cannot be undone.  The rounds on the deleted 
scorecards are permanently removed from their players’ scoring records.  
When a scorecard is deleted, all of the rounds, scores and other data for those 
rounds are deleted too.

Note: If the Remove button is not available (the button is dim), either there are no 
scorecards in the list selected for deletion, or the scorecard list has been locked to pre-
vent the addition or removal of scorecards(see “Authorization” on page 10).


